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Introduction
Welcome to the world of inexpensive, rugged, and accurate temperature and
humidity logging.  The TEMPRECORD range of loggers opens up new
opportunities in the field of temperature and humidity logging and verification.

This manual describes how to use the TEMPRECORD logger, TEMPRECORD
READER INTERFACE, the traditional TEMPRECORD FOR WINDOWS program,
and your IBM-compatible PC to read the TEMPRECORD loggers and generate
effective and professionally presented data from the results. The introduction
and use of the TEMPRECORD Relative Humidity & Temperature logger and
TEMPRECORD READER INTERFACE for the Palm PDA also features in this
manual.

We recommend that you first take the time to read this manual through in its
entirety before installing the TEMPRECORD program.  This will minimise the
chances of problems later on.  In the unlikely event you do have problems, see
the section 'When Things Go Wrong', on page 30.

The manual tries to present topics in roughly the same order as you will require
them.  It first deals with installing TEMPRECORD FOR WINDOWS, then setting
up a TEMPRECORD logger to record temperature samples, starting and stopping
the logger, reading the logged data, and finally viewing and printing the data.

The information within this manual is subject to revision and Temprecord
International reserves the right to make improvements to the operation and/or
specifications without notice.  Significant changes to the software program will
usually be detailed in the file README.TXT, found in the TEMPRECORD FOR
WINDOWS program.  The latest software version is available for download from
the TEMPRECORD web site at http://www.temprecord.com

 The Temprecord Logger Range
There are five main types of Temprecord temperature data loggers.

• The ‘Single Use’ model has a capacity of 7,937 samples (Inland) or 32,513
samples (Export).  It is started and stopped by snap-off tabs and is not
reusable.

• The ‘Econolog’ model provides an economy option with the same features
as the 'Multi-trip' MKIII. It has an accuracy specification to within 0.5°C.

• The ‘Multi-trip’ model has a capacity of 7,937 samples, is started by a hand-
held switcher, by pressing a button, or by the Temprecord program.  It can
be re-used.

http://www.temprecord/
http://www.temprecord.com/
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• The ‘Scientific’ model has a capacity of 32,513 samples, is started by a
hand-held switcher, by pressing a button, or by the Temprecord program.  It
can be re-used.  The Scientific model also has a wider operating temperature
range.

• The ‘RH’ model has a total capacity of 32,513 samples.  It may record
relative humidity, or temperature, or a combination of both.

 Features
Note that all logger specifications are subject to improvement and change.
Please consult the relevant specification sheet for current data, or visit
http://www.temprecord.com.

The TEMPRECORD logger range has been enhanced and released as the MK III
TEMPRECORD logger range of models.  The Mk III logger contains many
additional features, including:

• Programmable lower and upper temperature limits.

• LED indication of whether any logged sample has exceeded the preset
temperature limits.

• Ability to start at a predetermined time and date.

• Faster data download (when used with the associated Mk II Reader
Interface).

• Loop overwrite option, where the oldest samples are overwritten when
the logger fills.

• The ability to use a button on the logger to insert event markers into the
sample record.

• Starting and stopping with a button on the logger (Econolog, Multi-trip
and Scientific models only).

• The option to prevent starting and stopping with the switcher or the
button.

• Safe range entry option, where the samples are not checked against the
limits until the temperature has been within the programmed limits for a
certain number of samples.

• Non-volatile memory storage of recorded data (MKIII only) that may (in
most cases) be recovered after the internal battery has failed.
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 Versions 3.28 and later of TEMPRECORD FOR WINDOWS support both the
original TEMPRECORD Mk I and Mk II loggers and the current Mk III logger.
Previous versions of TEMPRECORD FOR WINDOWS are not compatible with the
newer Mk III loggers and the Relative Humidity RH logger.

 Mk III loggers require version 3.28 or later of the TEMPRECORD FOR
WINDOWS software.  If a previous version of the software is used with these
loggers, an error (‘Logger is incompatible’) is returned.

 

NOTE:  The TEMPRECORD data logger is a monitoring device only.  It does not
control, nor does it regulate temperature or humidity.   

Temprecord International Limited will not be responsible for any consequential
loss or damage caused as a result of the use of their products.

 Installing the Temprecord Program
The instructions following assume that you have received the program in the form
of the 3.5-inch installation diskette.  If you have downloaded TEMPRECORD FOR
WINDOWS from the Internet, you will need to generate an installation disk image
first as described in the section at the end of this chapter on page 5.

 In order to install and run the TEMPRECORD FOR WINDOWS program you will
need an IBM®-compatible computer preferably with a minimum of 32MB
RAM and a Pentium processor running Microsoft Windows 95/98/2000 or NT.

 You will have received the following in your TEMPRECORD Reader Interface
package:

• one copy of this manual

• one 3.5 inch floppy diskette

• one TEMPRECORD Reader Interface and attached cable

 The diskette contains the TEMPRECORD FOR WINDOWS program.  The
TEMPRECORD Reader Interface plugs into your computer and in conjunction
with the TEMPRECORD FOR WINDOWS program described in this manual,
allows you to program and read your TEMPRECORD loggers.

 The first step is to install the program.  The following instructions are for the
'default' installation, which assumes that:

• your diskette drive is drive A:
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• your hard disk is drive C:

• you want the TEMPRECORD FOR WINDOWS program to be placed in a
subdirectory (folder) on your hard disk called C:\TRW

 Unless you have good reason to change these defaults, we recommend you
stick with them.  If you already have TEMPRECORD for DOS installed on your
computer, installation of TEMPRECORD FOR WINDOWS will not affect that
program, and you can continue to use it if you wish.

 If you are installing version 3.18, or later, on a computer which already has
TEMPRECORD FOR WINDOWS installed, you can either install to a different
folder or the same place as the existing program.  If you choose to install it to
the same place as the existing TEMPRECORD FOR WINDOWS installation, the
existing version will be overwritten.

 Installing under Windows 95/98/2000/NT/XP
• Click on Start.

• Click on Run.

• Type A: SETUP, and click OK.

• Follow the installation instructions displayed on screen.  If the
installation procedure asks whether your existing copy of TRW.INI
should be overwritten, answer ‘No’.  This file contains all your
personal preference settings when running TEMPRECORD FOR
WINDOWS.

If your diskette drive is B: rather than A: substitute B: for A: above.

 Under Windows 95/98/2000/NT/XP, an entry Temprecord for Windows
will be added to the Programs entry in your start menu.  Within this entry will
be entries for the TEMPRECORD FOR WINDOWS program, the on-line help
system, the README.TXT file, and an entry for uninstalling TEMPRECORD.

 As part of the installation process, an icon called README.TXT will be
created in the TEMPRECORD FOR WINDOWS folder.  You should read the
contents of this file, as it may contain further information about TEMPRECORD
operation that was not available at the time this manual was printed.  To display
the contents of the file double-click on the README.TXT icon and it will be
opened with the Windows Notepad editor.

 Adding a Shortcut to Temprecord for Windows
 You may wish to start TEMPRECORD FOR WINDOWS from your desktop, or
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from a folder that you work from frequently.  The following procedure adds a
‘shortcut’ to TEMPRECORD FOR WINDOWS, which when double-clicked, will
start the TEMPRECORD FOR WINDOWS program.

• Open the folder where you want the shortcut to appear.

• With the mouse cursor over the folder, click the right mouse button.  If
you want the shortcut on your desktop, right mouse click on the desktop.

• Select New.

• Select Shortcut.

• In the edit box called Command Line, enter the path to the
TEMPRECORD FOR WINDOWS program file.  On most computers, this
will be ‘C:\TRW\TRW.EXE’ unless you have installed to a different
folder, or your computer is on a network.  Alternatively, use the Browse
button to find the file TRW.EXE.

• Click Next.

•  In the edit box called Select a name for the shortcut enter
Temprecord for Windows.

• Click the Finish button.

 Creating an Installation Disk
 This section is only relevant if you have downloaded TEMPRECORD FOR
WINDOWS via the worldwide web.   TEMPRECORD is always distributed via
electronic media as a single file, called a self-extracting archive.  The name of
the file always reflects the version of the program - for example, the file for
version 3.20 is called TRW320.EXE.  To create an installation disk:

• Download the file TRWnnn.EXE (where ‘nnn’ is the version number,
e.g. TRW320.EXE) to a temporary folder on your hard disk.

• Run the file TRWnnn.EXE.  This will create several more files in the
same folder.

• delete or move the original file TRWnnn.EXE

• Copy the remaining contents of the temporary folder to a newly
formatted, virus-free diskette.

This diskette will now serve as an installation diskette, and can be used to
install the program on as many computers as you wish according to the
instructions on page 3.  Alternatively, you can run the setup program
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SETUP.EXE from the temporary folder.

 The latest version of Temprecord software can be obtained free of charge from
http://www.temprecord.com.

 Connecting the Reader Interface
 Before starting the TEMPRECORD FOR WINDOWS program, if you wish to
program or read the data from a TEMPRECORD Logger, you should connect the
Reader Interface.  Your PC should have connectors at the rear for one or more
serial ports.  These are known as 'COM' ports and may be labeled COM1
through COM4.  Most computers have at least one port.  The connector will
either be a 9-pin male (DB-9M) or a 25-pin male (DB-25M).  The Reader
Interface is fitted with a DB-9F female connector.  If your computer is only
fitted with a 25-pin male connector, 9-to-25 pin adapters can be purchased from
most computer stores if one was not supplied with the Reader Interface.

 You can connect the Reader Interface to any available COM port.  Your
computer must have at least one unused COM port.

 WARNING – This is a Class A product.  In a domestic environment this
product may cause radio interference in which case the user may be required to
take adequate measures.

 The most recent model SR2 Reader Interface has three LEDs, which can serve
as an indication of current COM port activity.

• The LED marked Power should turn on as soon as the TEMPRECORD
program is first asked to communicate with a logger and remain on as
long as the program is running.

• The LED marked From PC will turn on whenever the PC is trying to
communicate with a logger.

• The LED marked To PC will turn on whenever the logger is responding.

 Under normal operation (e.g. when reading data from the logger, the two
Communications LEDs will flash alternatively as the program alternatively
asks for data from the logger and receives it.
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 Starting the Temprecord Program
 Once installation has been completed, you can run TEMPRECORD FOR
WINDOWS.

 Windows 95/98/2000/NT/XP
• Click on Start.

• Click on Programs.

• Click on the Temprecord for Windows program folder.

• Click on Temprecord for Windows.

 Alternatively, you can double-click on a shortcut if you have created one as
described on page 4.

 Using the HELP System
 At any time while TEMPRECORD FOR WINDOWS is running, you can request
help by various means:

• By pressing the F1 key.

• By clicking on a button labeled Help.

• By opening the Help menu.

 The help system is a comprehensive on-line manual that is fully 'context-
sensitive'.  This means that the help information you receive when F1 is
pressed or a Help button is pressed is normally directly relevant to the current
operation.

 If for example you attempted something that resulted in an error message -
clicking on the Help button when the error message was displayed would give
you a full description of the error, why it occurred, and what you might do to
avoid it.

 For general information on how to use the Windows Help system, press F1
while the help window is open.
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 Opening the Menus
 Across the top of the screen are displayed the five main groups of functions
TEMPRECORD provides - File, Program, View, Options and Help.  You can
open each of these menus by clicking on them with the mouse, or pressing Alt-
F for the file menu, Alt-P for the program menu, etc.

 You will notice that some of the menu entries have keys alongside them, e.g.
File/Read Logger has the key Alt+R.  These keys are 'short-cut' keys that
can be used to invoke that function.  They are an alternative to opening the
menus and selecting the function directly, in that they work from almost
anywhere in the program.

 Using the Speed-Buttons
 Most of the common functions in TEMPRECORD can be accessed by means of
the row of buttons (called 'Speed' buttons) below the main menu.
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 The graphic shown on each button is intended to provide a clue as to its
functions, but if you can't remember, position the mouse cursor above the
button for a few seconds and a 'hint' will appear telling you what that button's
function is.

 Using the Right-mouse Button
 Clicking on the right-mouse button will bring up a local menu of the more
common functions.

 These local 'pop-up' menus are particularly useful for quickly changing the
view mode of the current window.
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 Setting Up
 Some setting up may be needed to tailor the operation of TEMPRECORD FOR
WINDOWS to your particular needs.  All of these options are contained, not
surprisingly, in the Options menu.  TEMPRECORD FOR WINDOWS provides a
multitude of options, and these are presented as a series of tabbed pages.  You
can select each of the pages by clicking on the corresponding tab.  The tabbed
page corresponding to the option you selected from the menu is displayed in
front of the others.  If you open the Options menu and click on COM Port:

 

 If your Reader Interface is connected to a COM port other than the one shown
as Current TEMPRECORD Port, you will need to change the COM port setting.
Click on the correct COM port number.

 If you prefer temperature to be displayed in degrees Fahrenheit, click on the
General tab and select Degrees F.

 If you plan to print reports of the logged temperature, you should select the
Printing tab and set up the various printing options.
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 When you have finished setting up your options, click on OK to close the
Options pages.

 Note that TEMPRECORD FOR WINDOWS remembers all of these settings for
you, so there is no need to repeat this process every time you start up the
program.  The remaining options are discussed later in this manual, when the
functions they pertain to are covered.

 Checking for a Temprecord Logger
 If you have a TEMPRECORD logger, place it in the Reader Interface.  Click on
File, and then Query Logger.  A window will open indicating TEMPRECORD
FOR WINDOWS is checking for the presence of a logger in the reader.  If one is
found, after a second or two a window will open displaying a summary of the
data read from that logger.  The program reads just enough data from the logger
to provide a summary of the logger contents.

 If you receive the message ‘Unable to access TEMPRECORD logger’ make sure
the COM port is correctly set and the Reader Interface cable properly plugged
in.  The logger itself must be pushed fully into the Reader Interface cavity.

 TEMPRECORD FOR WINDOWS can be set up to automatically check for a logger
when the program starts, and you also can also make it check for a logger by
pressing Space.  To have TEMPRECORD check for a logger on start-up, Select
Options, then General, and make sure Check for Logger on Start-up is
checked.

 Programming a Logger
 Programming is the general term applied to setting up the TEMPRECORD
loggers to perform their temperature logging function.  All of the operations
described in this section assume there is a logger in the Reader Interface.  Each
operation is described in the order you would normally perform it.  Note that
some of the operations require knowledge of the logger's password, if this has
been set.

 To program a logger's parameters prior to use, click on Program, then
Parameters.  This will open the parameter form:

 

 

 If the logger is protected with a password, you will be asked to supply this
before you can continue.  The password will be a number of up to 8 digits.  It
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will not display as you type it.

 When you open the Parameters form, some of the options may be shown grayed
out.  This will be for one of the following reasons:

• The option is not appropriate – for example you cannot program the start
date and start time unless the Enable Start on Date option is checked.

• The option is not available because the logger the data was read from is an
older Mk I logger and these loggers do not support that feature.

 

 User Data
 Each TEMPRECORD logger has the facility to record up to six lines of user data.
These lines can each be up to 40 characters long.  If the TEMPRECORD logger is
being used for transportation monitoring, the user data might record
information such as the shipper's name, the type of cargo being monitored, etc.
You can type anything you like into the six lines of user data.

 Password
 If you want to change the password, you must enter the new password into
BOTH of the password fields. Once again, the password will not display as it is
typed.  The new password will only take effect if both entries are filled in and
they match, so take care in typing the password.  If the passwords do not match,
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or only one of the fields is filled in, you will receive an error message.  Entering
the password twice minimizes the possibility of a password unwittingly being
incorrectly entered.  Remember only digits (up to 8) are allowed in a password.

Do not forget your password.  Without the password, the logger cannot be
programmed or re-used.

 If you want to remove the password altogether (so anyone is able to program
the logger, whether they know the password or not), then the password must be
set to zero.  Once again, both fields must be filled in with the number '0'.  When
the password is zero, no password is required to program the user data, change
the password, set the start delay, set the sample period, or re-use the Econolog,
Multi-trip or Scientific TEMPRECORD loggers.

Make sure you have set the user data and password correctly.  Once the logger
has been started, it is not possible to change these.

 Start Delay and Sample Period
 The start delay is the time from when the logger is started until it actually
begins to measure and record temperature values.

 The start delay can be set to any value from ten seconds to 36 hours, in
multiples of two seconds. During this time the logger cannot be read or
stopped. The start delay is normally set at manufacture to one minute.

 The sample period is the time that elapses between temperature samples.

Beware of undersampling!  When plotting the temperatures, TEMPRECORD joins
the sampled points with straight lines, but there is no way of knowing what the
temperature was between the samples, particularly at longer sample periods.
Make sure the sample period is set to a sufficiently short duration to catch the
fastest expected variation in temperature.

 On the Inland, Econolog, and Multi-trip TEMPRECORD loggers, it can be set to
any value from two seconds to 2.5 minutes, in multiples of two seconds. The
sample period is set at manufacture to 2.5 minutes.

 On the Export loggers, it can be set to any value from two seconds to 36 hours,
in multiples of two seconds. The sample period is set at manufacture to 5
minutes.

 On the Scientific loggers, it can be set to any value from two seconds to 36
hours, in multiples of two seconds. The sample period is set at manufacture to
2.5 minutes.

 If you want to change the start delay or sample period, fill in the new values.
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They are both specified in hours, minutes, and seconds.

When entering the sample period and start delay, you don’t need to enter the
separator characters (normally a colon (‘:’) for times and a slash (‘/’) or hyphen
(‘-’) for dates).

 After re-using an Econolog, Multi-trip or Scientific TEMPRECORD logger you
can change the sample period and start delay if you wish. If you do not change
them after the logger is re-used, the start delay is set to the default value of one
minute and the sample period remains set to the value last programmed.

 You will receive an error message if you specify a seconds or minutes value
above 59, or an overall time above the maximum allowed.  Any time you do
specify will be rounded to the nearest 2 seconds.

 As you type in the new sample period value, the duration is calculated and
displayed to the right of the sample period.  The duration displayed assumes the
logger will fill to capacity.

Make sure you have set the start delay and sample period correctly.  Once the
logger has been started, it is not possible to change these.

 Start at Time and Date
 Instead of using the start delay to determine how long after starting before the
logger starts recording samples, you can program TEMPRECORD to start at a
particular time and date.  You must check the box 'Enable Start on Date
Option' before you can enter a time and date to start logging from.

 The logger will start recording samples from within a few seconds of the time
and date specified.  The time and date you specify must be in the future or an
error is reported when you try to update the logger parameters.

 It is still possible to start the logger by any of the other means, i.e. with the
switcher, the buttons, or by using the Program/Start Logger function of
TEMPRECORD.  It is however possible to program the logger so that it cannot
be started with the switcher and/or the button.  This is discussed later in this
section.  If the logger is started by any of these means, the start time and date is
ignored.  If you only want the logger to start at the programmed time and date,
make sure the other starting options are disabled.

 Lower and Upper Limits
 The Mk II/III TEMPRECORD loggers have the ability to compare the logged
temperatures against lower and upper limits, and report whether the limits have
been exceeded via the red and green LEDs on the logger.
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 The Program/Parameters form allows you to specify these limits.  You
must enter the limits in the same units as the current setting of the Units option
(°C or °F)

 When TEMPRECORD reads the data from a Mk II/III logger and displays it in
graph view mode, the limits that were programmed in the logger are shown on
the graph.  These limits are also used in the values view and statistics view.

 Safe Range Entry
 In some situations, the logger must be started while the temperature is outside
the limits and it is undesirable for this situation to be reported as a temperature
outside of the limits.  Also, there are applications where a brief excursion
outside the limits may be expected, but is not to be reported as an out-of-range
condition.

 If the Enable safe range option is not checked, logger samples are checked
against the limits from the time when the logger is started.  If the option is
checked, the temperature must enter the 'safe range' (i.e. it must be less than the
upper limit and greater than the lower limit) before it will be checked against
the limits.

 If the Enable safe range option is checked, comparison of the temperature
values starts as soon as the number of temperature samples specified in the
limit delay parameter have been inside the safe range.  For example, if the
Limit delay is set to 5, the checking of temperatures against limits will not
start until five successive samples have been recorded as inside the safe range.

Enabling the safe range entry option does NOT mean that the logger does not
start taking samples until the conditions for safe range entry are met.  Enabling
safe range entry means that the samples taken are not COMPARED against the
limits until the conditions for safe range entry are met.  The logger still takes
samples from the time the start delay expires (or from the start time and date, if
this is enabled).

 Limit Delay
 This option determines the number of consecutive samples that must occur
before a condition is met.  If this value is set to 5 for example:

• 5 consecutive samples must be taken between the lower and upper limits
before checking against the limits starts (provided  Enable safe range
above is checked).

• If Enable safe range is not checked then 5 consecutive samples
outside the limits must occur before an out-of-range indication is given
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by the logger.

• If Enable safe range is checked then once the safe range has been
entered, 5 consecutive samples outside the limits must occur before the
logger gives an out-of-range indication.

 Loop Overwrite
 Normally when TEMPRECORD has taken a number of samples equal to the
logger capacity, recording of samples stops.  It is possible however to program
the logger so that when it is filled, the following samples overwrite the oldest
sample.  The logger will from that time on therefore always contain a record of
the most recent 7937 samples (Inland, Econolog and Multi-trip loggers) or
32513 samples (Export and Scientific loggers).

 You can turn the Loop overwrite option on and off in the
Program/Parameters form.  If this option is not checked, the logger will
stop recording when it fills up.  If this option is checked, after the logger has
filled, subsequent samples taken overwrite the oldest sample.

 Start and Stop with Button
 You can determine whether the logger can be started and/or stopped with the
button in the Program/Parameters form.  If you want to be able to start the
logger with the button, check the option marked 'Start with Button'.   If you
want to be able to stop the logger with the button, check the option marked
'Stop with Button'.

 The button on the logger is used for both starting and stopping the logger, and
also for recording markers in the sample record.

 The button must be held down for at least 10 seconds to stop the logger.  If
Allow Markers is on, the logger will flash twice almost immediately to
indicate a marker has been inserted and then about 10 seconds later it will flash
4 times to indicate it has been stopped.  If Allow Markers is off, the logger
will flash 4 times to indicate it has been stopped button after about 10 seconds.

 Start and Stop with Switcher
 You can determine whether the logger can be started and/or stopped with the
switcher in the Program/Parameters form.  If you want to be able to start
the logger with the switcher, check the option marked 'Start with Switcher'.
If you want to be able to stop the logger with the switcher, check the option
marked 'Stop with Switcher'.

 You cannot prevent starting and stopping with the switcher of the older
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TEMPRECORD loggers.

 Allow Markers
 TEMPRECORD has the ability to record markers along with the temperature
data.  A marker is simply an indication of an event - no other information is
stored other than the fact that the button was pushed, and the time it was
pushed.  The time recorded is that of the most recently taken sample.

 To insert a marker, you must hold the button down for at least 2 seconds.  The
red LED on the logger will flash twice to confirm that a marker has been
recorded.

 This feature must be enabled by checking the Allow markers option in the
Program/Parameters form.  If this option is not checked, pressing the button
has no effect, unless stop with button is also checked, in which case pressing
the button for at least 10 seconds will stop the logger taking samples.

Once the marker has been recorded (i.e. when the LED flashes), be sure to release
the button immediately.  Remember that holding the button down for at least 10
seconds can also stop the logger!

 You can enter as many markers into the logger as you wish, but the
TEMPRECORD program only displays the first 100 markers recorded.

 Each marker occupies a sample position - i.e. for every marker you insert, the
sample capacity of the logger is reduced by one for that use.

 Updating the Logger
 Once you have finished setting the programming parameters, you can update
the logger by clicking OK.  If you click on Cancel instead, no changes will be
made to the programmed data in the logger.

 If you wish to update the programming parameters in the logger, but you do not
wish to exit the Parameters form, click on Apply instead of OK.  You can
think of the Apply button as being ‘Save', and the OK button as being 'Save
and Exit'.  The Apply button can be useful where several loggers need to be set
up with the same user data or sample period.

 Default Parameters
 TEMPRECORD FOR WINDOWS allows you to set up default parameters that can
be loaded just by clicking on the Defaults button in the
Program/Parameters form.  This is useful if you always set up your loggers
with the same sample period or start delay, or the six lines of user data are



Temprecord user manual

18

always similar.  To change the settings that are loaded when the Defaults
button is clicked, select Options, then Parameter Defaults.  Click OK when
you have entered your default parameters.

 Starting the Logger
Only the Econolog, Multi-trip, RH and Scientific model TEMPRECORD Loggers can
be started with the TEMPRECORD program.  If you are using the Inland or Export
TEMPRECORD Loggers, you will need to break off the corner of the plastic case
marked “START” to start these units.

 Once the logger has been programmed with the desired parameters it can be
started.  Open the Program menu and select Start.  You may then be asked to
confirm that you wish to start logging.  Answer Yes to this prompt and after a
few seconds the summary data displayed in the window should change to
indicate the logger is in the 'start delay' mode, that is, it is counting down the
start delay after which time it will begin logging.  When the logger is started,
the LED on the logger flashes 4 times to confirm this.  It will flash again after
the start delay period has elapsed and logging begins.

 Remember that Mk II/III TEMPRECORD loggers can also be programmed to
start at a particular date and time, and also by pressing the button.

Do not subject the Inland, Export, Econolog, or Multi-trip TEMPRECORD loggers to
temperatures below -25°C (-13°F) or above 60°C (140°F). The Multi-trip Blue
case, RH and Scientific loggers must not be subjected to temperatures below -
50°C (-58°F) or above 75°C (167°F).  Outside these temperatures the logger may
fail and logged data could be lost.  Models fitted with external probes are also
subject to these limits, but the probe itself can withstand a range of -50°C to
110°C (-58°F to 230°F).

 You can determine whether TEMPRECORD asks you to confirm that you want to
start the logger when you use the Start function from the TEMPRECORD
program.  Select Options, then General.  If the box labeled Prompt before
Starting is clear, you will not be prompted.

 Stopping the Logger
Only the Econolog, Multi-trip, RH and Scientific model TEMPRECORD Loggers can
be stopped with the TEMPRECORD program.  If you are using the Inland or Export
TEMPRECORD Loggers, breaking off the remaining corner of the plastic case stops
marked “STOP” will stop these units recording.

 To stop an Econolog, Multi-trip, RH or Scientific TEMPRECORD logger, place
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the unit in the Reader Interface, and click on Program, then Stop.  You may
then be asked to confirm that you wish to stop logging.  Answer Yes to this
prompt and the logger will flash four times to indicate it has been stopped.

If you have selected Loop Overwrite mode in a Mk II/III TEMPRECORD logger,
stopping the logger is the only way of preventing old samples being overwritten
once the logger has filled.

 Remember that Mk II/III TEMPRECORD loggers can also be stopped by
pressing the button.  The button needs to be held down for about 10 seconds to
stop the logger.

 You can determine whether TEMPRECORD asks you to confirm that you want to
stop the logger when you use the Stop function from the TEMPRECORD
program.  Select Options, then General.  If the box labeled Prompt before
Stopping is clear, you will not be prompted.

 The Temprecord Switcher
 The Temprecord Switcher is a hand-held unit that provides an alternative
method of starting and stopping the Econolog, Multi-trip and Scientific loggers.
It looks very much like a Reader Interface, but it has no attached cable, and
does not need to be plugged in to a computer in order to function.

 To start the TEMPRECORD logger with the Switcher, the logger is placed in the
cavity of the Switcher, and the Start button pressed.  The LED on the switcher
will turn on for approximately two seconds, and during this time, the
TEMPRECORD logger should flash four times to indicate it has started.  At this
time, the start delay will begin counting down as normal.

 To stop the TEMPRECORD logger with the Switcher, the logger is placed in the
cavity of the switcher, and the Stop button pressed.  As when starting, the LED
on the switcher will turn on for approximately two seconds, and during this
time, the TEMPRECORD logger should flash four times to indicate it has
stopped.

Note that you cannot stop the logger until the start delay period has elapsed. If
you want to prevent the logger being stopped accidentally after starting you
should program the logger with a longer start delay time.

 If the LED on the Switcher should flash when either of the buttons is pressed,
rather than remaining on continuously, this indicates the battery should be
replaced as soon as possible, as the Switcher will soon fail to function reliably.
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The Switcher itself gives no indication as to whether the TEMPRECORD start or stop
operation was successful.  However if the TEMPRECORD logger itself does not flash
4 times when the start or stop buttons are pressed, you can assume the operation
was NOT successful.  You can only start a logger that is new or that has just been
re-used.  You can only stop a logger while it is logging.

 Re-Using the Logger
 The Econolog, Multi-trip and Scientific TEMPRECORD loggers can be re-used
after each use.

 In order to re-use a logger, you must know the password, or the password must
be zero, and the logger must have been stopped.  Place the stopped logger in the
Reader Interface, click on Program, then Re-use.  You may be asked to
confirm that you wish to re-use the logger. If you answer Yes to this prompt
the logger will be re-used.  The logger is then ready to be programmed with
new user data and sample period and start delay.  A new password may be
programmed also.  If you do not alter the password, the existing one remains in
force.

When a TEMPRECORD logger is re-used, the start delay is reset back to a default
value of one minute. Make sure you program this again if your requirements are
different from the default. The sample period is not altered when a logger is re-
used. Whatever the sample period was for the last use will be the sample period
after re-using, unless you alter it.

 You can determine whether TEMPRECORD asks you to confirm that you want to
re-use the logger when you use the Re-use function.  Select Options, then
General.  If the box labeled Prompt before Re-using is clear, you will not
be prompted.

 Reading a Temprecord Logger
 In order to view temperature values, statistical data or a graph of the logged
temperatures, the logger’s data must be read.  Click on File, then Read
Logger.

 While the logger is being read, a window will open and display a progress bar
showing how far (in percent) the operation has progressed.  Reading the data
from a full logger can take a minute or two. You can abort the reading of a
logger by clicking on Cancel.
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 Displaying the Logged Temperatures as a
Graph
 Once a logger has been read, the view mode of the window will change to
Graph View.  The resulting display will initially be scaled so that the entire
logged temperature history is displayed on screen.

 

 When the graph is displayed, there are various keys that can be used to navigate
around the plot.  These are described below.  You can also press F1 from the
graph mode display for more help.

 right-
arrow

 Moves the cursor one sample to the right.  If the
cursor is at the right-most position of the screen, the
trace will scroll.

 left-
arrow

 Moves the cursor one-sample position to the left.  If
the cursor is at the left-most position of the screen,
the trace will scroll (unless you are already
positioned at the start of the trace).

 Ctrl-
right-
arrow

 'Skips’ the cursor to the right.

 Ctrl-left-
arrow

 'Skips’ the cursor to the left.

 up-
arrow

 Scrolls up the graph, i.e. brings higher temperatures
into view.

 down-
arrow

 Scrolls down the graph, i.e. brings lower
temperatures into view.

 +, =  Expands the trace vertically about the cursor.  The
vertical magnification is increased, such that the
position of the trace at the cursor remains in the

 



Temprecord user manual

22

same position on the screen.  Use this key to
examine small changes in temperature in more
detail.  If you are using a notebook computer without
a dedicated + key, use the = key instead.

 -  Contracts the trace vertically about the cursor.  The
vertical magnification is decreased, such that the
position of the trace at the cursor remains in the
same position on the screen.

 Shift+,
Shift=

 Expands the trace horizontally about the cursor.  The
horizontal magnification is increased, such that the
position of the trace at the cursor remains in
approximately the same position on the screen.  The
trace cannot be expanded past the point where there
are less than 4 samples across the screen. If you are
using a notebook computer with a reduced keyboard,
the Shift+ key function is obtained by pressing Shift=.

 Shift-  Compresses the trace horizontally about the cursor.
The horizontal magnification is decreased, such that
the position of the trace at the cursor remains in
approximately the same position on the screen.

 Home  Moves to the start of the logged temperatures.
 End  Moves to the end of the logged temperatures.
 F1  Displays help information about the View/Graph

display.
 F4  Scales the plot so that the entire record is visible

onscreen.  This is the same scaling as performed
when a file is first viewed.

 F5  Moves to minimum temperature and places the
cursor there.  Note that the search for the minimum
and maximum values only takes place over the
samples between the start and end markers.  If you
want to find the minimum or maximum value of the
whole record, make sure the start marker is set to
the first sample and the end marker to the last
sample.

 F6  Moves to maximum temperature and places the
cursor there.  See the comments for the F5 key
above.

 F7, F8  Sets the start and end markers for the statistical
functions, printing, and 'zoom between start and end
markers' (see the F9 key) functions. These markers
are displayed on the trace as small flags, provided
marker display is enabled.  When a file or logger is
read, these markers are set to the first and last
samples.

 F9  Zooms the trace between the start and end marker
samples.
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 Notice that holding the Shift key down in conjunction with the cursor keys
'multiplies' the action of the key, e.g. Shift-right-arrow jumps the cursor to the
right.

 Numerous options control the way the graph view is presented.  Select
Options, then Graph to see these.  You can set the colors used when
displaying the graph for example.

 Zooming and Presets
 TEMPRECORD FOR WINDOWS provides numerous functions for changing the
vertical (temperature) and horizontal (time) scales of the graph.  The zoom
functions are available from the View menu, or from the pop-up menu when
the mouse cursor is over a graph.

 Presets are a particularly useful function.  They allow you to explicitly set the
time and temperature span of a graph.  This is especially handy when you want
to view or print data from two different loggers and compare them.

 You can set the preset times and temperatures explicitly from the
Options/Graph page, or you can use the View/Zoom/Assign Presets
function to assign the presets from the time and temperature span from the
current graph window.  You can then use the View/Zoom/Zoom Preset
function to force the graph in any other window to show only that time and
temperature range.

 Printing a Graph
 To print the currently displayed graph, click on File, then Print.

 The region of data printed corresponds to the region currently displayed on the
graph on screen, so you can obtain a printout of the whole data record, or any
section of it, as desired.  TEMPRECORD FOR WINDOWS has numerous printing
options you can use to format your printed reports.  For example, you can print
any combination of the summary, statistics, values or graph.  If the graph and/or
values are printed, you may select whether the samples printed consist of all the
samples, just those displayed in the graph in the window, or just those samples
between the start and end markers.  Select Options, then Printing to change
these settings.

  If you are using a colour printer, the colors used will match those displayed on
the screen, and may be changed under the options menu.  A colour printer may
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be forced to print black and white only if the printer driver allows for this.

 Displaying the Logged Temperatures in Table
Form
 If you change the view mode to Values, you can display the logged
temperatures in tabular form.  Click on View, then Values, or open the pop-up
menu with the right mouse button and select Values:

 

 Note that the number of columns displayed across the window can be altered.
Select Options, then Values, and change the Columns setting.  You can
also select whether the values wrap to the next line when they reach the right-
hand edge of the window or not.  This does not affect the number of columns
used when printing the data in reports, or when exporting the data to a disk file
in ASCII format.  These are determined by separate options.
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 Statistical Data
 Sometimes it is useful to obtain statistical data from the logged temperature.
Click on View, then Statistics to change to the statistics view mode.

 Statistics for all Samples
 The statistical information displayed consists of:

• The mean temperature (i.e. the average temperature).

• the maximum temperature reached

• the minimum temperature reached

• The number and percentage of samples that were above the upper
limit.

• The number and percentage of samples that were below the lower
limit.

• The number and percentage of samples that were both above the upper
limit and below the lower limit.
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 Statistics for Samples between Start and End Markers
 The above parameters are calculated for all of the samples read from the logger.
If you have set start and end samples that are different from the first and last
samples in the logger, the above parameters are calculated again using only
those samples between the start and end samples.  This is useful when you want
to exclude a portion of the data record, e.g. the time when the logger was not in
a controlled environment.

 PHI Statistics
 TEMPRECORD FOR WINDOWS can also calculate and display PHI (Process
Hygiene Index) statistics.  To enable this facility, click on
Options/Statistics, and make sure Show Growth Statistics is checked.
The PHI statistics are displayed after the statistics for all samples and statistics
for samples between the start and end samples are displayed.  The PHI statistics
are calculated between the start and end samples only.

The PHI statistics are presented as a guide only.  They do not represent any
actual measured growth of organisms present in the monitored environment.  The
statistics calculated are based on information and techniques developed by the
Meat Research Institute of New Zealand.

 For more information on the derivation and application of PHI statistics,
consult the appendix on page 33.

 Printing Statistics
 The information presented in the Statistics view can also be printed.  Click on
Options/Printing and make sure Statistics is checked.  The statistics for the
samples between the start and end samples are only printed if the start and/or
end samples are set to samples other than the first and last samples.  The PHI
statistics are only printed if the Show Growth Statistics option is checked.

 Saving a File
 When the data has been read from a TEMPRECORD Logger, you will probably
want to save that data, so that it can be examined or printed later without
needing to read the data from the logger again. Click on File, then Save to
save the TEMPRECORD Logger contents as a disk file.  This disk file can be
loaded back into the TEMPRECORD program at a later date and viewed or
printed, just as if it had been just read from a logger.

 You can give the data file a name that reflects the file’s contents and thus
makes it easy to locate and load at a later date.  You should type in a name that
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is relevant to the data contained in the file, e.g. 'STORE33' if the data file was
from a logger placed in cool store number 33.  The name can be up to 8
characters and must not contain any embedded spaces.  An error message will
result if the filename does not conform to the requirements.

 Type in the name, and click on OK.  TEMPRECORD will save the file and add a
file type of '.TR', so the file in the example above would be called
STORE33.TR.  You can override the default file type if you want, but the
TEMPRECORD program always assumes .TR if the file type is not specified and
deviating from this convention could cause confusion.

 If a file of the name you specified already exists, TEMPRECORD will ask you to
confirm that you really wish to overwrite the existing file of the same name.

 If you want to save the file into a different folder, specify the folder as well, or
change to that folder first.

 Loading Another File
 Once you have saved a file in the manner described above, you can then load it
at a later date.  To load a TEMPRECORD data file, click on File, then Open.  A
dialog window will open allowing you to enter a filename.

 Type in the name of the data file you wish to load, and click OK.  If you cannot
remember the name, you can scroll through the list of TEMPRECORD data files
in the current folder and click on the one you are interested in.

 Once a file is loaded, you can graph it and print it as if it had just been read
from a logger.

 You can open as many files as you like, and even open the same file more than
once.  Each data file is displayed in its own window.  You can use the
View/Cascade, View/Tile Horizontally and View/Tile Vertically
functions to arrange the windows.

 Picking a File
 Each time you load or save a data file TEMPRECORD places the name of the file
in a 'pick-list' of recently used files.  This list is appended to the file menu.  If
you click on the name of a file on the File menu, TEMPRECORD will open the
file.  If it is already open, but hidden behind other windows, it will be bought to
the front.

 The files are listed in order of access, with the most recently accessed file at the
top of the list.
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 Adding Comments to a File
 It is a good idea to choose a filename that reflects the contents of the
temperature data when saving a file, but it is not always possible to do this in
the filename itself.  For this reason TEMPRECORD FOR WINDOWS allows you to
add  'comments' of up to 10 lines of 64 characters each to each file.  These
comments can be changed at any time and the file saved again.  The comments
can contain anything you wish.

 To inspect (and if desired, change) the comment lines of a file, click on File,
then Edit Comments.

 The labels displayed on the left of the comment lines can also be changed.  This
is useful where particular information needs to be entered into the comment
lines - the labels can serve as a ‘prompt’ for the user.

 The comments are normally displayed in the Summary View, and also printed
as part of the summary.  If you do not normally use the comments facility you
can prevent them being displayed or printed by un-checking the option Print
comment fields in the Printing options.

The labels are assigned to the TEMPRECORD data at the time the logger is first read
and cannot be altered from that point.  Make sure the default labels are set up for
your requirements before you read the logger.  The comment fields can be edited
at any time however.

Data files created with earlier versions of the TEMPRECORD program only support
a single comment line.  If you load one of these files the label fields are ignored
and you cannot enter anything in fields 2 through 10.

 Exporting Data (Saving a File in ASCII)
 Sometimes it is necessary to save the data from a logger or a data file in a
format that can be read from other programs, such as word-processors,
spreadsheets, and database programs.  This is sometimes called 'exporting' data
to another program.  TEMPRECORD FOR WINDOWS can save a file in 'ASCII'
format for these purposes.  Click on File, then Export.

 A dialog window will open asking you for the filename.  The sample range, the
data format, and the number of samples to average over can all be changed in
the Export Options page, along with other options for exporting data.

 TEMPRECORD allows you to specify the format of the ASCII files so that it will
be compatible with your spreadsheet, database program, etc.  Click on
Options, and select the Export page tab:
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 Exiting from the Temprecord Program
 Once you have finished with TEMPRECORD FOR WINDOWS, you will want to
exit the program.  To do this, click on File, then Exit Temprecord.
TEMPRECORD FOR WINDOWS may ask you to confirm you really want to leave
the program.  Click on Yes.  If you have read a TEMPRECORD logger and have
not yet saved the data to a disk file, you will be asked if you wish to do this
before exiting.  You should answer Yes to this question if you want to save the
data.  If you answer No, TEMPRECORD will exit without saving the data.

 The Alt-X key can be used as a short-cut to exit from TEMPRECORD FOR
WINDOWS.  You can determine whether TEMPRECORD asks you to confirm
that you want to exit the program when you close TEMPRECORD.  Select
Options, then General.  If the box labeled Prompt before Exit is clear,
you will not be prompted.
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 When Things Go Wrong
 This section is a collection of common problems experienced by first time (and
later!) TEMPRECORD FOR WINDOWS users, and the likely solution.  Remember
that most problems experienced during operation of TEMPRECORD FOR
WINDOWS can be resolved by pressing F1, the help key.  A Help topic dealing
with common problems is also available from the program.  Click on Help,
then Common Problems.

 I get a 'Sector not found' message during installation.

 Messages of this sort usually mean a faulty diskette or drive.  If the drive
reads other diskettes successfully, contact your dealer for a replacement
TEMPRECORD diskette.  Otherwise, try using a head-cleaning diskette in
the drive and then attempt installation again.

 I can't get the program to recognize the TEMPRECORD logger in the reader.

 Make sure the COM port setting in the Options menu matches the COM
port you are using.

 Make sure the logger is fully inserted in the Reader Interface.  It must be
inserted with the snap-off tabs (or the corner hole, in the case of the
Econolog, Multi-trip and Scientific loggers) facing towards you.

 The Reader Interface can be unreliable in conditions of bright light.

 Make sure your COM port is not being used by another program.
Normally, TEMPRECORD FOR WINDOWS will report that it could not
open the COM port if it is already in use by another program, but with
some programs, particularly fax/modem reception software, your
computer may become unresponsive.  You may need to close the
fax/modem reception program while you use TEMPRECORD.

 The TEMPRECORD logger itself could be non-operational. Check for this
by inserting another TEMPRECORD logger in the Reader Interface and
checking for its presence by pressing the spacebar.  If that logger does
not respond either, the problem is more likely to be confusion over COM
ports.

 If you are using an additional RS-232 cable as an extension cable, all the
RS-232 control signals must be wired.  '3-wire' RS-232 cables cannot be
used.

 Operation of the Reader Interface may be unreliable with some
notebook-style computers.  This is because the reduced voltage levels at
the COM ports are insufficient to power the Reader Interface.
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 I get strange characters appearing when I print graphs.

 Check that the selected Windows printer matches the actual printer you
have.  Check whether you can print with another application, e.g. a word-
processing program.  If this does not print properly either, the fault is
with your printer setup.

 There are known problems with some Windows 95/98 printer drivers.  It
may be necessary to select a driver for a printer similar to the one you are
using.  For example, the HP 600 series of printers may need to use the
HP 310 driver to print.

 Shift + doesn't expand the graph.

 You cannot expand the graph past the point where there are less than 4
samples across the screen.

 If you have a 'notebook' style computer with a reduced keyboard, you
will need to use the =  key instead of the + key to expand the graph.

 I can't see the trace anywhere in the graph.

 Press F4 to scale the trace so that it fills the screen.  If it is still not
visible, you may have a data record with only one sample in it.  You can
also click on View/Go To/Find Trace to bring the trace into view.

 The times displayed on the graph don't agree with what I expect.

 Is the time and date on your computer set correctly?  Was the logger data
you are viewing recorded in another part of the world (i.e. in a different
time zone)?  Was daylight savings time in effect then, and it isn't now, or
vice-versa?  Any of these will result in a time difference. Remember that
TEMPRECORD FOR WINDOWS displays all times with reference to the
time of the receiver, i.e. the viewer of the data.

 I can't move the cursor onto parts of the trace.

 You can only place the cursor on sampled points.  The data in between
the sampled points does not exist in reality so TEMPRECORD skips over
them to the next recorded temperature.  See the note on page 13
concerning under-sampling.

 My logger seems to 'lose' samples occasionally.

 The TEMPRECORD logger can be read while it is still logging, but does
not log any samples while actually being read.  If you have a short
sample period (e.g. 2 seconds) and you read the logger, it will effectively
stop sampling for the time it takes to read the logger.
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 I can't get my Switcher to work

 Your Switcher battery may be flat. If the LED on the switcher flashes
when the buttons are pressed, or fails to come on at all, replace the
battery.

 You can't use the Temprecord Switcher to start and stop the Inland and
Export type TEMPRECORD loggers.  These can only be started and
stopped by snapping off the tabs.

 Your logger may have already been previously started or stopped.

 Your logger may be faulty.  Try placing the logger in a Reader Interface
and check it with the TEMPRECORD program.

 Some of the Options are ‘grayed out’ in the parameters form

 Some of the parameters that can be programmed are only supported in
the Mk II/III logger.  You cannot alter these if the data was read from an
older Mk I logger.

 The ‘High-speed Download’ option is not available when running
Windows 2000 or Windows NT.
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Humidity Logger
Data from TEMPRECORD RH loggers can only be viewed with TEMPRECORD FOR
WINDOWS software version 3.28 and any new releases of Temprecord for
Windows beyond version 3.28.

 The only noticeable difference apart from the cosmetics of the logger when
visually comparing an TEMPRECORD RH logger to a temperature only logger is
the presence of an aperture in the front of the RH logger case, this is where the
humidity sensor is located.
 
 TEMPRECORD Humidity loggers functionally are exactly the same to operate as
the Temperature only loggers covered in the previous chapters of this manual.
 
 Therefore when seeking instructions on how to Start / Stop and Download data
and also access the other commonly used functions of the RH logger you
should refer to the earlier chapters of this manual that cover these topics.

Setting up your Humidity Logger
 
 The Parameters Dialog box for TEMPRECORD RH loggers can be accessed in
the same manner as for Temperature only loggers.
 Refer to page 11 - Programming a Logger.
 
 From version 3.28 on there have been some new additions to the Parameters
form of Temprecord for Windows software. These are used when setting up the
humidity functions of the RH logger before recording.
 
 The first of the new added controls in the Parameters form has the title
Logging.
 
 This control gives you the option to select whether the logger will record
Temperature only, Humidity only or both Temperature and Humidity data.
 
 Select the Logging option you require before starting the logger.
 The second of the new controls added to the Parameters form of the software
has the title Humidity.
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 Humidity Lower and Upper Limits
 TEMPRECORD Humidity loggers have the ability to compare the logged
Humidity against lower and upper limits, and report whether the limits have
been exceeded via the red and green LED’s on the logger.
 
 The Program/Parameters form allows you to specify these limits.
 When TEMPRECORD reads the data from a Humidity logger and displays it in
graph view mode, the limits that were programmed in the logger are shown on
the graph.  These limits are also used in the values view and statistics view.
 
 

 
 
 
 For explanations of the other controls on the Parameters form above that have
not been covered here, Refer to the earlier section between page 11 and page 18
of this manual headed Programming a Logger.
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Displaying Humidity Data.

 Graph view
 You can view both Humidity and Temperature data simultaneously in graph
view.
 The numerical scale on the y-axis at the left-hand side of the graph is
representative of the data values for both of the adjacent Temperature and
Humidity data traces displayed on the screen.
 The portion of the numerical scale of the y-axis adjacent to the Humidity trace
is interpreted as a percentage between 0.00% and 100% RH.
 The portion of the numerical scale of the y-axis adjacent to the Temperature
trace should be interpreted in degrees Celsius or Fahrenheit depending on what
you have selected in the Units selection control on the Options / General form.
 

 
 
 
 The numerical scale across the x-axis at the bottom of the graph is Date and
time data.  The format of the Date displayed on the graph is determined from
the regional settings of the computer you are using.
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 Minimum and Maximum value speed buttons.

 
 
 If you wish to quickly view the minimum and maximum values from the
Temperature and Humidity graph displayed on screen you can do this by
clicking on the minimum and maximum value speed buttons highlighted in the
image above.
 
 For instance if you wanted to check the minimum value on the graph click on
the minimum value speed button and the red cursor line on the graph will jump
to the minimum Temperature value.
 
 If you click on the minimum value speed button again the red cursor line on the
graph will jump to the minimum Humidity value.
 
 Again if you click on the minimum value speed button the red cursor line will
jump back to the minimum Temperature value, so you can see by clicking
repeatedly on the minimum value speed button you can cycle between the
minimum values from the displayed Temperature and Humidity data.
 
 The same order of events applies when you click on the maximum value speed
button that is if you have both Temperature and Humidity data displayed on
screen.

 

 Values view
 The image of the Values screen on the next page shows the time the data
values were recorded in the left-hand column, next the Temperature value is in
the center column and finally the Humidity value is displayed the right hand
column.
 
 The four white boxes located just below the speed buttons are the lower and
upper alarm limits that were set in the Program / Parameters form.
 
 The pair on the left side is the Temperature lower and upper alarm limits.
 The pair on the right side is the Humidity lower and upper alarm limits.
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 If you require multiple columns displayed on the Values screen go to the
Options / Values menu and select the number of columns you require using the
now open Values option form then click on OK.

 Font Selection.
 Another control available on the Options / Values form is Font selection this
allows you to display the Values data in a font that is currently installed on the
computer you are using.
 

 Font Colors
 Four individual Color selection controls give you the option to change the font
color of the Temperature data, Humidity data, and also the Date and Time font
color.
 
 By using the forth Color selection control labeled Markers you can change the
color of the data value that indicates when the Marker button was pressed.
 

The selected font color for the Markers value will only be displayed if the Allow
Markers option was checked on the Parameters form before logging was started,
and if the button on the logger was pressed for 2 seconds while the logger was
recording data.

The red LED in the logger will flash twice to confirm a Marker has been inserted
into the data stream after the button is pressed.
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 Columns / Font / Color selection controls on the Options / Values form.
 

Dust on the Humidity Sensor
To minimize the effects of airborne dust building up on the Humidity sensor use
an optional dust cover to protect the Humidity sensor.

 Tests have proven that the proprietary dust cover that is shown below
protecting the Humidity sensor does not affect the performance or accuracy of
the Temprecord RH logger.
 
 The dust covers have been designed and manufactured to allow maximum
airflow to reach the Humidity sensor while at the same time preventing dust
and other airborne contaminates settling on or around the RH sensor.

 
 
 The dust covers simply slide over the logger and are held in place by the tight
fit of the cover around the logger case.
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 When the dust cover becomes congested by dust, try washing the cover in
warm water after removing it from the logger, then rinse the dust cover out
thoroughly in clean water.
 Make sure the cover is 100% dry before fitting it to your logger again.
 
 If the dust cover becomes unusable because of damage or soiling you can
obtain replacement dust covers from your TEMPRECORD distributor.
 

The dust covers are manufactured from a non-absorbent material.  Do not use a
substitute such as filter paper as other materials can become saturated with
moisture.  This will cause the RH logger to record far higher Humidity values and
not the actual Humidity level present in the intended environment being logged.

Drying the Humidity Sensor
NEVER USE A MICROWAVE OVEN TO DRY THE HUMIDITY SENSOR.

Doing so will immediately void the warranty of the logger and seriously damage
the electronics and battery inside the unit beyond repair.

 If the humidity sensor in the logger needs to be dried out the following
procedure applies.
 
 Place the logger face down for six hours in a conventional oven that has been
set to 50 degrees Celsius / 122 degrees Fahrenheit. After that turn the logger
over for the remaining 18 hours. There should be no more than 5% Relative
Humidity present inside the oven during the drying process.
 Leave the logger inside the oven for a minimum drying time of 24 hours to
return the RH sensor to calibration conditions.
 Never exceed 70 degrees Celsius / 158 degrees Fahrenheit during the drying
process as this could damage the logger.
 

 
 Drying the Humidity sensor in a conventional oven as recommended.
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 Appendix - Calculation and Use of Process
Hygiene Index Values

 Introduction
 The following text is based on a document supplied by The Meat Research
Institute of New Zealand.  It describes how to apply the PHI values calculated
by TEMPRECORD FOR WINDOWS.

 Microbes and meat
 Meat at slaughter is sterile (Gill, 1979). Microbes that can cause food poisoning
and/or spoilage begin their activities after contaminating the exposed surfaces
of meat. A typical organism often found associated with meat is Escherichia
coli. This organism is an important pathogen. It also has growth characteristics
that are similar to other mesophilic pathogens (viz. organisms that grow well in
warm environments) such as the salmonellae. Measuring the ability for E. coli
to grow on meat is therefore a useful indication of the potential for mesophilic
pathogens to grow generally.

 Bacterial growth
 Bacteria grow and multiply on the meat surface at a rate determined by
physiological capacity and the availability of water, space and nutrients. Fresh
meat provides a moist and nutritious environment for bacteria to grow on. This
means that bacterial growth will be effectively limited only by the cell
physiology. Having said this, meat surface drying is sometimes used to control
growth. However, it is difficult to prove effective application of drying on a
non-uniform product such as fresh meat. Furthermore, the effect of drying is
difficult to quantify. It should be assumed then, unless proven otherwise, that
there will always be areas on the surface of meat that can allow unrestricted
growth of bacteria. Manipulating the physiological growth capacity of the
organisms then best effects control. This is best done using temperature.

 Generally speaking, bacteria grow faster as the temperature rises. The faster
they grow, the faster they can reach numbers that can result in disease or
spoilage. Thus, by minimising initial bacterial numbers (using hygienic
processing techniques), cooling meat quickly and maintaining low storage
temperatures, food safety and storage potential will be maximized. To have
confidence in the product such techniques need to be ‘measured’. Initial
bacterial numbers can be minimized by good manufacturing practice and
assessed by classical microbiological techniques. The ability for the bacteria to
grow during processing can be assessed by re-assaying meat at the process end.
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This is, however, a slow process and does not give an indication as to how each
processing step contributes to the overall microbial bio-load. An alternative
method uses predictive microbiology in the form of the Process Hygiene Index
(PHI).

 The Process Hygiene Index
 PHI is a means of assessing the potential growth of a microbial indicator
organism during a process. The PHI is a numerical value that is equivalent to
the growth of a microbial indicator organism (E. coli) over a process
temperature history collected by an electronic data-logger. The higher the index
value, the greater the potential for E. coli growth. For example, an index of 0
(zero) indicates no growth potential, 10 indicates a potential for 10 generations
of growth (i.e. an E. coli cell has the potential to reproduce 10 times).

 The probe
 A special probe is manufactured for use in PHI applications.  The logger probe
is tapered and composed of Teflon. This allows easy insertion and retrieval
from product (especially after freezing when other materials may stick). Teflon
also is a poor conductor of heat so the probe tip, which contains the sensor, will
allow a faithful measurement of the local temperature.

 Positioning the probe
 The probe is positioned to measure temperature at a site that reflects the
process’s greatest ability to allow bacterial growth. This means that the logger’s
probe must be attached to the warmest meat surface site (where bacterial
contamination occurs) and the monitored meat must follow the process through
its warmest path. Deep tissue temperature, whilst warmer than the surface
during the initial carcass cooling phase, is NOT used because deep tissue is
sterile and bacterial growth does not therefore need to be considered. If the
warmest path is not known, or is variable, a number of samples (e.g. carcasses)
are monitored that are representative of the load. For a carcass the slowest
cooling site is adjacent to the aitch-bone pocket (bovine) or within the cavity
adjacent to the 5th and 6th lumbar vertebrae (ovine). After cold boning, the
probe should be placed on the surface of a small cut, which has the ability to re-
heat at the fastest rate. After warm/hot boning a large cut is used because it will
cool the slowest. After packaging (including offals) the probe is placed at the
thermal centre of the load (e.g. between two cuts at the centre of a box in the
centre of the load). Further specifications can be tailored for your own process
or obtained from the appropriate regulatory literature.
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 Types of processes
 Before calculating a process PHI an operator must decide what type of process
they have monitored. This involves two considerations. Firstly, is the process
one or two-phase? Secondly, is the process aerobic, anaerobic, or a mixture of
the two?

 One-phase or Two-phase?
 Processes such as carcass cooling and offal cooling are termed ‘single phase’
processes because they are composed of a single cooling period containing no
periods where product is handled requiring removal of the temperature logger.
A temperature history is collected simply by attachment of the probe to the
slowest cooling site. For surface sites, the probe is inserted into a stainless steel
disc which is then pinned to the meat surface using a non-heat conducting (i.e.
Teflon®) staple. The logger should be placed with the product as soon as
possible. There may be regulatory requirements relating to your process
describing when and where probes are placed. For carcass cooling, the surface
temperature should be above 25° C at the beginning of the process and below
7° C at the end (which is the minimum temperature for E. coli growth). At the
end of the process the logger is interrogated and a PHI produced.  Note that 2
models of disc are available - one for beef and one for mutton.

TEMPRECORD FOR WINDOWS expresses PHI values both with and without lag. This
lag refers to the period of time that bacteria need to adjust to a new environment
before they can start to grow. For use with fresh meat processing  DO NOT USE
VALUES EXPRESSED AS ‘WITH LAG’. This is because bacteria that
contaminate meat are considered to have resolved their lag phase by the time
process monitoring is commenced.

 When a single-phase process is followed by a second operation the overall
process is termed ‘two-phase’. An example is where a carcass is cooled (first
phase), boned and the packaged cuts chilled (second phase). During this
operation the temperature logger is used to measure the first phase as described
for the single-phase operation. The logger is then removed for the boning
operation and then placed with the packaged product to continue the monitoring
process. There may be a regulatory limit on the maximum length of time the
logger can be absent from the product between the phases (e.g. one hour for
carcass/cuts assessment).  The PHI value for a two-phase process can be
calculated as follows:

Remember that you must have the Statistics option 'Show Growth Statistics'
checked in order for TEMPRECORD FOR WINDOWS to display PHI statistics.

 1. In Graph View, mark the start and end of the first phase of cooling.  You
can do this quickly by positioning the graph cursor at the start of the first
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phase of cooling, and pressing F7.  Then position the cursor at the end of
the first phase of cooling and press F8.

 2. Switch to Statistics View.  TEMPRECORD FOR WINDOWS will then show
a value for the PHI for the first phase. The expressed PHI will either be
for aerobic growth (e.g. carcass cooling) or anaerobic growth (e.g. offal
cooling- although this will be a one-phase process only).

 3. Repeat step 1 for the second phase of cooling.

 4. Repeat step 2 for the second phase. The PHI will be either for anaerobic
growth (e.g. warm-boned bulk packed meat or vacuum packaged cuts) or
aerobic growth (e.g. unwrapped cuts).

 5. Manually calculate the potential for aerobic growth during the inter-
phase period. This is done by firstly choosing the maximum temperature
occurring at either the end of the first phase or the start of the second
phase and then calculating the amount of potential aerobic growth for the
inter-phase period using the following formula, used by the PHI software
algorithm and presented in the paper of Reichel et. al. (1991).
 Y = (0.0513x - 0.17)2, when x is between 7 and 30°C

 Y = (0.027x + 0.55)2, when x is between 30 and 40°C

 Y = 2.66, when x is between 40 and 47°C and

 Y = 0 when x is < 7°C or > 47°C

 Example:

 If the first phase ends at 7° C and the second phase starts 0.75 hr later at
12° C, you need to calculate 0.75 hours aerobic growth at 12° C.
 ((0.0513 x 12) -0.17)2 = 0.2 generations potential growth
per hour.

 The inter-phase PHI is therefore 0.75 x 0.2 = 0.15

 6. The three PHI values (first phase, second phase and inter-phase) are then
added together to give a process PHI.

 7. For two-phase processes that contain an aerobic first phase followed by
an anaerobic second phase, results that are marginally (e.g. within 0.2
generation) above specified upper limits for the process, can be
recalculated taking into consideration the short aerobic-to-anaerobic lag
period during which cells cease to grow while converting their
metabolisms to anaerobic respiration. This method is described in
Reichel et al. It is a tedious process to accomplish manually and may not
significantly influence your result - however it is an option for those
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operators who want to keep their results faithful with those generated by
MIRINZ AP1 software (presently incompatible with TEMPRECORD
loggers). A future release of TEMPRECORD FOR WINDOWS will produce
a PHI value for a two-phase process and will calculate the lag
automatically.

 Uses for PHI
 In addition to establishing if a process allows a potential for E. coli proliferation
that is within certain guidelines the PHI technique can be used for:

•  Comparing processes (e.g. chiller runs).

•  Assessing the effect of process modifications on allowing
microbial growth.

•  HACCP (Hazards Analysis Critical Control Points) applications.

 Inappropriate applications of PHI
PHI is not a method to calculate actual bacterial growth on product. A PHI
value reflects the maximum potential for a process to allow the growth of E.
coli and similar organisms. There may be reasons why actual E. coli growth is
lower. For example, some product may have a pH unfavorable for maximum
growth, some product may dry sufficiently to retard growth, while other
product within the process may not be contaminated with E. coli.

 The Future
MIRINZ and TEMPRECORD are continuing to develop and improve software
and hardware for extending the scope of the PHI. In addition to pursuing this
application of predictive microbiology for food safety, they are also working on
a similar application for predicting the growth of spoilage organisms. This will
allow processors to monitor and optimize storage processes to minimise the
growth of spoilage organisms and thus maximize the storage life of chilled
product.

 References/Further reading
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 Temprecord for Palm.

 

 Introduction

Thank you for using Temprecord for Palm software its availability now offers
you even more flexibility in the range of options to choose from when
downloading and viewing data from your Temprecord loggers.

Temprecord for Palm is an intuitive and easy to use program, however by using
the instructions provided in this manual we will walk you through the
installation of Temprecord for Palm software to your Palm.

Also covered are instructions on how to connect and remove your Palm to and
from the SR3 Reader Interface.

With a SR3 Reader and Palm running Temprecord software you can perform
the following tasks.  Reset a logger, Start and Stop a logger and most
importantly you can download and view the data from your logger as a graph.

Installing Temprecord for Palm software.

If you do not have an installation disk supplied with the Reader Interface or you
just want to download the latest version of Temprecord for Palm you can get a
copy of the program from our website www.temprecord.com/software.html

http://www.temprecord.com/software.html
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You will need a copy of Winzip available from www.winzip.com to unzip the
archive file supplied on the floppy disk or downloaded from our website.

If you have a floppy disk with the trpalmxxx.zip file (where xxx is the version
number) place it into the a:\ drive of your computer and copy the
trpalmxxx.zip file to a temporary folder of your choice.

Go to the temporary folder and double click on trpalmxxx.zip file.  Winzip
will open with all of the trPalm setup files displayed. Go to step (B).

If the install disk has 10 Palm installation files already listed instead of the
single trpalmxxx.zip file go to step (B).

(B) Locate from the list Setup.exe and double click on this file.  This will start
the install process, and as each of the four-individual message screens pop up
during the setup process read the instructions and then click on the OK button
to carry on with the install process.

On completion the install process will place the file TempRecord.prc into the
Palms install folder.

This is the file for the Temprecord program that will run on your Palm.

Place your Palm into your HotSync cradle and do a HotSync.  When that has
completed Temprecord will now be installed on your Palm.

 Fitting your Palm to the SR3 Reader Interface.

On your SR3 Reader interface there is a Palm connector already fixed to the
Reader case and a piece of Velcro that is used to secure your Palm to the
Reader case.

http://www.winzip.com/
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Remove the backing paper off the Velcro, and leave the two pieces of Velcro
on the Reader attached to each other do not remove the Velcro off the Reader.

Next fit your Palm into the Palm connector on the Reader case, while doing this
keep the top end of the Palm raised above the adhesive side of the Velcro on the
Reader for the time being.

Now center the Palm over the Reader while still connected into the Palm
connector and carefully lower the Palm onto the exposed adhesive of the Velcro
patch so that the Velcro and the Palm stick together.

Lastly check that the DB9F plug from the Palm connector cable is secured into
the back of the Reader.

Note. The cable connecting the SR3 Reader to your Palm is a proprietary item
and should the cable be damaged through misuse it is not protected by the 12-
month warranty term that covers the SR3 Reader Interface.

 Removing your Palm from the Reader Interface.

To remove your Palm from the SR3 Reader Interface lay the Reader on a flat
surface and then press the release button on the top of the Palm connector that
is attached to the Reader.

The Palm will eject forward about 2mm or ⅛”, now you can separate the two
Velcro halves by lifting the Palm up and away from the Reader case.

Note. We have found from trials that the Velcro patch fixed to your Palm does
not interfere with the Palm unit while it is in the Palm docking cradle.
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Starting Temprecord for Palm

         

 Viewing the data

Locate the Palm TR icon on the main screen of
your Palm and tap on the icon with the stylus to
open the Temprecord program.

See image 1 to the right, the Palm TR icon can be
seen in the third column on the third row of icons.

Temprecord for Palm software will now open with
an opening screen as pictured in image 2 below

 Image 1

To read and view the data from the logger in the
SR3 Reader Interface take the Palm stylus and
tap on the Read Logger button located at the
lower left-hand corner of the Palm screen.

Doing this will start communications between
the logger in the SR3 Reader Interface and your
Palm.
 Image 2
49

Note. Make sure the cable between the Palm
and Reader is securely connected.
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 Image 3
When data from your logger is being
downloaded into your Palm you will see a
message box informing you of the download
progress similar to the one pictured to the
right labeled Image 3.

Once the data download is complete another
message box will briefly open telling you
that the Palm is processing the data and it
will then close.

When that has finished you will see a screen
similar to Image 4 (Right) showing you the
name of the TR files currently in the Palms
memory and available for viewing as a
graph.
0

o view the graph for a TR file from the file list take the Palm stylus and tap on
e file from the list that you wish to view.

 graph of the data from the file you selected from the list will be displayed on
e Palm screen.

ote. The RH / temperature files from Humidity loggers will show as two
imilarly named file entries in the file list joined together by square bracket
ymbol at the left-hand side of the two files.

he square bracket on the RH / Temperature files indicates to you that they are
 fact one file.

 Image 4
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The reason you have two files is one represents the temperature data and the
other represents the RH data.

The Palm cannot display both RH and temperature graph traces at the same
time.

You will need to select either the temperature or humidity file individually by
tapping on the file name from the file list in the main screen to view the data
you wish to look at.

A copy of Temprecord for Windows software can be downloade
www.temprecord.com/software.html
 Image 5
Image 5 shows a typical graph output screen of the
Palm, the Y axis displays temperature in this case
the units are in Celsius, but Fahrenheit can be
displayed by selecting Fahrenheit through the
options menu.

The X-axis displays the date and time scale, the
axis information is displayed in the same format as
you would see in Temprecord for Windows.

Although it appears that the fine 0.01 temperature
resolution is not displayed on the Palm screen it
has been saved with the TR file and can be seen
after you HotSync the file back to your PC and
view the file in Temprecord for Windows
software.
51

d from

http://www.temprecord.com/software.html
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Zooming in and out of the graph

To zoom in on a graph to get more detail use the Palm stylus to highlight the
word IN on the zoom button located at the bottom left corner of the graph
screen.  See Image 5 for detail.

When the word IN on the zoom button has been highlighted tap anywhere on
the graph with the Palm stylus and the graph will zoom in.  Keep tapping on the
graph screen with the Palm stylus until you get the level of detail you want.

When the Palm beeps at you and no longer zooms the graph that means you
have reached the maximum level that the Palm can zoom to.

To zoom out so the entire graph can be displayed on the Palm screen is a
reversal of the zoom in process that is use the Palm stylus to highlight the word
OUT on the zoom button located at the bottom left corner of the graph screen.

When the word OUT on the zoom button has been highlighted tap anywhere on
the graph with the Palm stylus and the graph will zoom out.

Again the Palm will beep at you and no longer expand the graph out when the
maximum level of graph expansion has been accomplished.

 Scroll navigation arrows

If you look at the center bottom of the graph screen in Image 5 on the previous
page you can see two buttons each one has an opposite facing arrowhead
graphic on it.
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You use these navigation scroll arrows after you have zoomed in on a graph
and you want to shift the graph display to the left or right.

Tap the scroll buttons with the Palm stylus to move the graph in the direction of
your choice.

Status information screen.

The Status information screen pictured in Image 6
gives you some basic information about the logger
file you have open in Temprecord for Palm software.

The picture of the Status screen is pretty well self-
explanatory the information given is. Logger type.
Either temperature or humidity only or both
temperature and humidity.

Sample period.  This is the sample period used by
the logger for the file you have open.  The format is
HH.MM.SS.

Upper limit / Lower limit.  If these were set into the
logger during the Program \ Parameters setup in
Temprecord for Windows.

They will be displayed on the graph as two horizontal
lines adjacent to the upper and lower temperatures on
the Y-axis.  See Image 5 for detail.
Image 6
53
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Programming a logger

 Start a Data Logger

With a logger in Ready to use mode you can start the logger by p
the Reader and tapping on the Start logging data button this cau
programmed start delay period to count down and then the logg

 Stop logging data

To stop a logger place it into the Reader and tap on the Stop logg
button doing this will stop the logger recording data.

 Reuse Logger

This function must be used before you can restart a logger to reco
happens to the logger during this process it is that all of the data 
logger is wiped from the memory and the logger is reconfigured 
setup parameters i.e. sample rate that were used in the previous s
data.
Image 7
If you look at Image 4 you will see a button
located at the bottom right corner of the screen
with the words Program It.

If you tap on the Program It button with the
stylus a new screen will appear that looks like the
one pictured to the left in Image 7.
lacing it into
ses the pre
er will start.

ing data

rd data.  What
stored in the
with the same
ampling of
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The limitation here is you cannot change any of the setup parameters i.e.
sample rate you will need to use Temprecord for Windows to make any
changes to the settings of the logger before sampling of data can be started.

 Exit

Tapping on the EXIT button with the stylus will return you back to the main
screen of Temprecord for Palm it will not exit the program as you could be
excused for thinking.

Options menu

The Options menu can be accessed in two ways.
The first way is to take the stylus and tap on the
menu icon located at the bottom left hand corner on
the silk screen of the Palm.

Alternatively you can tap on the blue title bar at the
top of the Palm screen this also will open the
Options menu.

The Options menu is not active while the graph is
displayed.  You will need to display the main screen
before making any changes from the Options menu
as pictured in Image 8.
Image 8
55
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 About

 Delete All

Delete will delete all TR files from the file list on the main screen
You cannot delete individual files.
From the Options menu if you tap on the About menu
item you will get a screen similar to the one at the left.
This screen displays the following information.

The version of Temprecord for Palm software you have
installed.

The Palm OS version your Palm is running.

 The software copyright date.

Temprecord International Ltd contact information.
 Image 9
 when used.
 Image 10
  Image 11
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Delete All will only delete TR files displayed in your file list, it will not delete
the Temprecord for Palm program.  If you tap on the Delete All menu item the
message pictured in Image 10 will appear asking you to confirm or cancel the
action.  If you proceed by tapping on the OK button then the message in Image
11 will appear telling you that all files have been deleted successfully.

 Celsius and Fahrenheit

By tapping on either the Celsius or Fahrenheit menu items from the Options
menu you can change the way the temperatures are represented on the graph.

Be aware that the menu items from the Options menu can only be activated
from the main screen they cannot be changed while you are in graph view.

Transferring files from your Palm to your PC

The Palm HotSync process is used to transfer Temprecord data from your Palm
to your desktop PC.

If you have TR data in your Palm this will be sent to a folder on your desktop
called C:\Palm\User name\TR.

Where User name is the name you entered during the CD setup of Palm
Desktop software.

Temprecord for Palm will create the TR folder for you at the first HotSync
session between your Palm and your PC only after the Temprecord software
has been installed on your Palm and assuming you have TR data files to
transfer from your Palm to your PC.
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Once the TR data files have been transferred to your PC you can go to
C:\Palm\User name\TR folder and then copy or move the TR files to a folder
of your choice.

Using Temprecord for Windows you can open the TR files from the folder you
saved them to for further processing of the data.

Optional battery

The SR3 Reader Interface has the option to fit a 9-volt battery to boost the
power in the Reader when required.

You will need to fit a 9V battery when the SR3 Reader Interface is used with
computers that have a low serial port voltage at or below 6 volts dc.

Additionally the power management applications running in some laptop
computers reduce the voltage to the serial port/s of the computer as the battery
in the laptop starts to fade away.

If the serial port output voltage of the computer is less than 6 volts the SR3
Reader will cease to operate and a 9V battery will need to be fitted to the SR3
Reader to restore communications between the Reader and computer.

A 9-volt battery is only required when the computer or Palm communications
port output is below 6 volts.

 Fitting the battery

The battery is located under the cover that has the Palm connector mounted on
it.  To replace the 9V battery start by disconnecting and removing the Palm
from the SR3 Reader Interface.

Next unscrew and remove the DB9F serial cable plug from the serial connector
at the rear of the SR3 Reader.
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Using a square drive screwdriver remove the two screws from the small cover,
it is the one with the LED visible and the Palm connector fitted to it.

Now lift the rear end of the small cover up and then back from the rest of the
SR3 Reader case.

The battery can be Unclipped and removed from the Circuit board of the SR3
Reader Interface.

To replace the battery and cover is a reversal of the battery replacement
procedure detailed above.

 Replacing the battery cover screws

Important:  When replacing the battery cover do not over tighten the two
retaining screws for the cover “just lightly nip them up”.  If you over tighten the
screws you will strip out the thread in the plastic case of the SR3 Reader.  If this
happens you will no longer be able to secure the battery cover in place.
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